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Overview

Description and Requirements

Blackout is a game for Microsoft Windows.    It is a fun way of learning to use a mouse, since the better 
your mouse skills are, the higher your scores are likely to be.    Blackout should run on any computer with 
a functioning version of Microsoft Windows version 3.0 or greater.    A mouse or other pointing device is 
required.    Certain features of Blackout may only function in Windows version 3.1 or greater, since these 
features require the multimedia capabilities of Windows 3.1.

Blackout is fully configurable for users of all ages and skill levels, offering a variety of scoring and 
playability options, as well as switchable options for different game elements.    Choose the Configure 
Game... choice from the Game menu to access the Game Configuration dialog box.    

When running under Windows 3.1 on a computer with the appropriate sound hardware and software 
drivers, Blackout will allow the player to setup different game sounds, by assigning .WAV files to play 
when different game events occur.    Choose the Sound Setup... choice from the Game menu to access 
the Sound Setup dialog box.

The Object of the Game

The object of Blackout is to find and click on all target blocks before all non-target blocks turn black.    The 
Playing the Game section explains the basics of the game.

In addition to finding target blocks, the playing is kept more challenging and interesting by the addition of 
Bonus Blocks, Replay Arrows, the Boogeyman, Moving Targets, and Sequenced Targets.    Proper use of 
Bonus Blocks and Replay Arrows allows much higher scores, but overuse can increase the risk of having 
a blackout occur, which will cut the score by 50%.    The addition of the Boogeyman and Moving Targets 
can make play more challenging. To learn more about these elements of Blackout, read the Rules of the 
Game section
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Playing the Game

The object of Blackout is to find and click on all target blocks before all non-target blocks turn black.    The 
following section explains how to play the game.

To "Find" a Block:

Using the mouse, move the mouse cursor so that it points inside of one of the target blocks.    Now, press 
the left mouse button ("click" it).    The target should turn red, and have an "X" drawn through it.    If the 
game's "Sound" option is turned on, you should hear the "Found Target" sound.

In addition to the target blocks, you may see some of Blackout's special playing elements, including 
Bonus Blocks, Replay Arrows, and the Boogeyman.    To learn more about these elements, read the Rules
of the Game section.

To Start a New Game:

From the Game menu, choose New, or click on the New button.

Monitoring the Game's Status

Several aspects of the game's status are constantly displayed in the game's status line, which is at the 
bottom of the game window.    The status line will always have the current score and game level, and, 
during play, will have accurate counts of the number of target blocks remaining to be found and the 
number of black blocks on the screen.    In particular the target-block count is helpful when you don't know
how many blocks are left to find.

One of the handiest features of the status line is the display of the percentage of colored blocks 
remaining.    During game play, this display appears as a "percent complete" bar which always shows the 
number of colored blocks left as a percentage of the original number of colored blocks.    When you are 
scoring bonus blocks, be sure to monitor this bar.    When it gets past 90% or so, it's time to click a replay 
arrow, or finish the level by clicking the remaining targets.
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Rules of the Game

Blackout Rules:

The game is paused until you make the first mouse click.    At that point, the game will start, and the 
colored blocks will begin to change color and some will begin to turn black.

Target Blocks: 

Each time you correctly click on a target block, your score will be increased.    Each time you click on any 
non-target block, that block and the eight others surrounding it will immediately turn black, as a penalty for
clicking in the wrong area.    Depending on the current setting of the Scoring Parameters points may be 
subtracted for a wrong click.

At the completion of each level, that game will pause and you will see a dialog box with the current game 
score.    Clicking on the "OK" button in this box will start the next level.    At each level, the score awarded 
for a correct click increases.    Also, at each successive level, there are more target blocks to find.    If, at 
the end of a level, all "found" targets still remain on the screen, you will be awarded a bonus score equal 
to the total of all clicked targets or one-half of your current score, whichever is greater.

Your chances of achieving this bonus are directly related to how long you try to score bonus blocks, since 
missing a bonus block adjacent to a target or found target will remove that target or found target from the 
screen, eliminating your chance for a bonus at that level.

The level is over when no more target blocks remain to be found, or when there are no more normally-
colored blocks (a "blackout").

The game is over when no more levels remain to be completed (there are 10 levels), or when a blackout 
occurs at any level.

Note that Blackout's scoring rules, playability settings, defaults, optional features, game-grid size, and 
game sounds can be altered by changing the game's configuration.

If a blackout occurs, the score is lowered by 50%.

If a player achieves one of the 10-highest Blackout scores, the high scores dialog box is automatically 
invoked, allowing the player to enter their initials.    The high-score table is then updated with the player's 
initials and score.    To enter your initials, either type them in the box provided or click on your initials from 
another high-score entry.    Press the enter key or click the "Ok" button when you have completed viewing 
the high scores dialog box.

Bonus Blocks:

While playing the game, there will occasionally be "Bonus Blocks" which will appear momentarily.    Each 
bonus block is a light-gray block with yellow circles.    The number of circles in the block will indicate the 
level of bonus to be awarded if the block is clicked on before it disappears.    The two-circle block is worth 
twice as many points as a regular target block.    The three-circle block is worth three times as much, and 
so on.    There are two-circle through five-circle blocks available, and clicking on them can greatly 
enhance your score - but be careful!    Spending time finding the bonus blocks may cause you to be 
unable to complete the level, and result in a Blackout, which definitely won't help your score.

You can enable and disable bonus blocks by choosing the Configure Game... choice from the Game 
menu, and turning off the Bonus Blocks option in the Options section of the Game Configuration dialog 



box.

Clicking on a bonus block will turn that block's circles blue.    Don't click on a bonus block that has already 
been clicked - that's the same as clicking on one of the colored    blocks.

The Replay Arrow:

Another element of Blackout is the "Replay Arrow".    The replay arrow is a black block with two colored 
arrowheads pointing in the direction of the arrow's movement.    The replay arrow will appear at random 
times.    It always moves from one edge of the playing surface to the opposite edge, and usually moves 
quite rapidly.    If you can successfully click the replay arrow, all black blocks on the playing surface will be 
returned to the normal, colored state.    This will allow you to get a second chance to complete a level, or 
to continue to play the bonus blocks at a level.

You can enable and disable replay arrows by choosing the Configure Game... choice from the Game 
menu, and turning off the Bonus Blocks option in the Options section of the Game Configuration dialog 
box.

Normally, replay arrows "bounce" off of a target block, and their direction is reversed.    If you don't want 
arrows to bounce, you can turn this behavior off by choosing the Configure Game... choice from the 
Game menu, and turning off the Bouncing Arrows option in the Options section of the Game Configuration
dialog box.    Note that, under certain conditions, a bouncing arrow can be "trapped" on screen, increasing
your chances of clicking on it.

Be very careful with replay arrows, since a "near miss" (within one block of the arrow's real location), will 
be counted as a miss, and you will "kill" the arrow.    Only click on it when you have a clear shot, or when 
you are desperate for time.

The Boogeyman:

The "Boogeyman" is a black block with a red-eyed face.    If this block appears, you will be unable to score
until you successfully click on it.    As the boogeyman moves around on the playing surface, it will 
occasionally restore a target block from a "found" state to an "unfound" state, causing the target to 
reappear.    Since the speed of the boogeyman's movement can make it very difficult to click on, there is 
no penalty associated with a "miss" when you try to click on the boogeyman - wild, uncontrolled clicking 
may be the only way you can get it! You cannot score any targets or bonus blocks when a boogeyman is 
present, and there will be no replay arrows during the time a boogeyman is on the screen.    Blocks will 
continue to turn black, however, so you should get the boogeyman as soon as possible after it appears.

You can enable and disable boogeymen by choosing the Configure Game... choice from the Game menu,
and turning off the Boogeymen option in the Options section of the Game Configuration dialog box.

Moving Targets:

Moving targets are an optional element of Blackout.    You can turn this element on and off by activating 
the game configuration dialog box from the Game/Configure Game... menu choice.    When moving 
targets are enabled, the target blocks will occasionally shift their positions.    This makes them more 
difficult to click, and occasionally results in mistaken clicks, when a target moves out from under the 
mouse cursor, just as the player "clicks" on it.

You can enable and disable moving targets by choosing the Configure Game... choice from the Game 
menu, and turning off the Moving Targets option in the Options section of the Game Configuration dialog 
box.



Sequenced Targets:

Sequenced targets are another optional element of Blackout.    You can turn this element on and off by 
activating the Game Configuration dialog box from the Game/Configure Game... menu choice.    When 
sequenced targets are enabled, only a single target on the playing surface at any one time may be 
clicked.    This target is visually marked with a yellow background.    Clicking on any target except the 
yellow target will result in a mistaken click.    A mistaken click near the next target in sequence may "kill" 
the target, and Blackout will randomly select another target on the game grid and turn it yellow.

You can enable and disable sequenced targets by choosing the Configure Game... choice from the Game
menu, and turning off the Sequenced Play option in the Options section of the Game Configuration dialog 
box.

Draggable Targets:

Draggable targets are an advanced element of Blackout.    When draggable targets are enabled, you can 
use the right mouse button (not the left one) to drag unclicked targets around the screen.    If bouncing 
arrows are enabled, you can use this feature to set an "arrow trap" by dragging targets to either side of a 
replay arrow.    This will "trap" the replay arrow and allow you to click it more easily.    This technique works
best when you trap the arrow in a single block, so that it is unable to move at all.

You can enable and disable draggable targets by choosing the Configure Game... choice from the Game 
menu, and turning off the Drag Targets option in the Options section of the Game Configuration dialog 
box.

Note that use of this technique can tempt you to waste a lot of playing time trying to trap an arrow instead 
of just clicking it, or continuing to play.    Use this technique carefully, or it can actually lower your scores 
by causing you to have more blackouts.    The technique is mainly useful for trapping an arrow early in an 
advanced level, so that you can guarantee that you'll have enough time to click all the level's targets and 
receive the bonus points.
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When you click a target, it is marked as found, like this one:    



When you click a bonus block, it is marked as found, like this one:    



When you click a replay arrow, all black blocks are returned to their normal, colored state, extending your 
time on the current playing level.



When you click a boogeyman, it disappears, and play returns to normal.



When you click the sequenced target, it is marked as found, like this one:    



Strategy and Hints

This section contains helpful hints for playing Blackout successfully.

· Use the mouse to click the target blocks as smoothly as possible.    "Jerky" mouse motions will result 
in mistaken clicks and lost bonus opportunities.

· Discipline yourself to locate and click all target blocks in a given area of the game surface before 
moving to a new area.    This results in less mouse movement and faster play, as well as preventing 
mistaken mouse-clicks.

· Establish a pattern of motion for locating target blocks.    Move from upper left to lower right, for 
example, or in an up-and-down vertical "sweeping" pattern.    Be consistent in your strategy, and your 
speed will increase.

· Use the Configure Game... choice from the Game menu to establish a default starting speed and 
level appropriate for your level of skill.    This prevents having to set the level and speed manually at 
the start of each game, and also keeps a skilled player from having to play through levels that are too 
easy.

· Play at the fastest game-setting you can play effectively.    Your scores are multiplied by the speed at 
which you are playing (Slow=1, Medium=2, Fast=3), so you can score much higher points at the 
faster play settings.

· Learn how to effectively use Bonus Blocks!    They can greatly increase your scores, since they are 
worth multiples of the current level's normal target block score.    Just remember that you must finish 
each level without a Blackout , so that play can continue, so spending too much time on Bonus Blocks
can backfire!

· The Replay Arrow can be used with dramatic results, since successfully clicking on it erases all of the 
current level's black blocks.    This means you will have more time to finish the level, or to continue to 
score the bonus blocks at that level.    But be careful not to wildly click around the area where a replay
arrow is, since missing it means you are lowering your score and increasing the number of black 
blocks.    You can also "kill" the replay arrow with a "near miss", so you should only click on it when 
you have a clear shot, or when you are desperate for time.

· Since there may be times when the playing surface just seems to get ahead of you, and there may be
no way to get all of the target blocks in time, it is possible to "live to fight another day" by deliberately 
clicking on non-target blocks which are close to groups of target ones.    This has the effect of 
"sacrificing" your ability to score on the target blocks (and your chances for a bonus score), in return 
for avoiding a Blackout, so that at least you can move to the next level.    

Note that the advisability of using this technique depends on the Scoring Parameters settings, since 
there may be too stiff of a point penalty for deliberately causing black blocks for this technique to be of
any use.

· Use draggable targets to set "arrow traps" to guarantee yourself plenty of time to click all the targets 
of an advanced level, thus assuring yourself of the level's bonus points.
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Game Menu Commands

New

Starts a new game of Blackout.    You can start a new game at any time, even in the middle of a game.    
You can also start a new game by clicking on the New button.

Pause

Pauses the game and stops all color changing.    You can pause a game at any time.    Choosing Game 
Pause again will toggle the paused game back to active.    Another way to reactivate a paused game is to 
simply click on a target block.    You can also toggle the pause-mode on and off by clicking on the Pause 
button.

High Scores...

Displays a dialog box showing the 10 highest scorers' initials and their scores.    Press the "OK" button in 
the dialog box to continue.    This dialog box is also used to collect the player's initials when the player 
achieves a score in the 10 highest.    You can choose this item at any time, even in the middle of a game.

Score...

Displays a dialog box showing the current game score and level.    Press the "OK" button to continue.    
You can choose this item at any time, even in the middle of a game.

Configure Game...

Displays a dialog box containing all of the game playing parameters.    It is possible to reconfigure the 
game's scoring rules, playing behavior, default startup level and speed, and game grid-size from this 
dialog box.    You can choose this item at any time, even in the middle of a game.

For more information on game parameters and how to set them up, see the Game Configuration dialog 
box topic.

Sound Setup...

Displays a dialog box containing sound setup parameters.    This menu choice allows you to assign any of
the eight Blackout sound events to either an internally-generated sound effect, or to a multimedia .WAV 
file.    If you have sound-making hardware installed on your computer, and have installed the appropriate 
Windows drivers for this hardware, you can use the Sound Configuration dialog box to assign any of the 
supplied .WAV files to any Blackout sound, or you can assign your own .WAV files to any of these sounds.

In addition to .WAV files, Blackout has eight internally-generated sound effects, one for each Blackout 
sound.    If you have set the sound setup dialog box to play an internally-generated sound, the sound will 
either be played through your computer's speaker, or through the standard Windows sound device.    
Certain Windows setups replace the speaker device with a driver which allows attached sound hardware 
to provide synthesized sounds.    With the appropriate sound driver and hardware, Blackout will provide a 
list of different sound-types, which you can assign to each of the internally-generated sound effects.    For 
more information about where to get such a driver, see the Credits and other information topic

For more information about the use of this dialog box, refer to the Sound Setup dialog box topic.

Exit

Immediately stops the current game and closes the Blackout application.    You can choose this item at 
any time, even in the middle of a game.





Options Menu Commands

Level

Displays a second-level menu with 10 choices.    Each of the 10 choices displays a successively more 
difficult level.    You can immediately move to any level by choosing the desired level from this menu.    The
level can be changed at any time, even in the middle of a game.    The current level will appear on the 
level menu with a checkmark to its left.

Sound

Choosing this item toggles game sounds on or off.    If game sounds are currently ON, a checkmark will 
appear to the left of the Sound menu choice.    Otherwise, no checkmark will appear.    Turning sound OFF
disables all game sounds made by Blackout.    You can choose this item at any time, even in the middle of
a game.

Speed

Displays a second-level menu with 3 choices - Slow, Medium and Fast.    The game speed determines 
how fast colored blocks will change colors, and has a dramatic effect on how quickly the colored blocks 
will black out.    The fastest speed is the most difficult.    You should also note that the faster the speed 
settings, the more points you can score (and lose), since Blackout multiplies each score-change by the 
speed-level (Slow=1, Medium=2, and Fast=3).

Display toolbar

This setting toggles the display of the toolbar on and off.    The toolbar contains several command buttons 
which can be clicked with your mouse to operate Blackout more quickly and easily.    If you disable display
of the toolbar, you can display it again, by choosing this choice from the menu.

Display status line

This setting toggles the display of the status line on and off.    The status line maintains a constantly-
updated display of Blackout's playing status, including the score, the current black-block count, the 
current target-count, the playing level, and a percent-complete indicator for the current level.    Watching 
the status line during display can help you to keep up with game play, and achieve higher scores.

Color Options

Displays a second-level menu which allows you to choose the color-settings for Blackout's playing grid.    
The three choices are:

16 Pure Colors
Random Dithered Colors
Random Pure Colors

3D Effect

Toggles Blackout's display between the normal appearance, and a special 3D appearance, where the 
playing surface appears to be formed from three-dimensional blocks.    By default, Blackout's 3D effect 
causes blocks to appear as "raised" blocks.    The 3D effect can be controlled by special settings in 
Blackout's initialization settings, however.    Documentation for these settings is available to registered 
users from the Help menu's Advanced Topics choice, which is added to the help menu when you enter 
your registration number.

Note that the 3D effect can significantly slow down screen-redraws, especially when used on slower 



computers or on computers without accelerated graphics controllers.



This setting causes Blackout to use only the 16 standard Windows colors.



This setting causes Blackout to use random colors, which may appear "dithered" on your screen, 
depending on your Windows display driver.    For 8-bit display drivers, this setting and the one above it 
reduce system overhead during Blackout play, and may reduce the number of screen redraws necessary.



This setting is only available when you are playing Blackout with an 8-bit or higher display driver.    
Blackout will use a spectrum of 256 pure colors from which to choose a color for each colored block on 
the playing grid.    Note that use of this setting may increase Blackout's system overhead, and, for palette-
based display drivers, may increase the number of screen redraws when switching away from and back 
to Blackout.



Toolbar Buttons

Pause          

Clicking this button toggles the game's pause state.    If the game is "playing", this button will appear 
normal, and clicking it will pause the game.    If the game is "paused", this button will appear to be 
pressed, and clicking it will start the game again.    When you start a new game, minimize Blackout, or 
switch away from Blackout to another program, this button will always be "pressed" for you.    

This button is equivalent to choosing the Pause choice from the Game menu.

New            

Clicking on this button starts a new game.    If a game is currently in progress, Blackout will display a 
dialog box asking permission to end the game.    If the game is paused, or if you answer "Yes" to the 
dialog box asking if you want to end the current game, a new game is initialized.      You may see the high 
scores dialog box before the new game is started, if the score of the previous game was high enough to 
qualify.    This button is equivalent to choosing the New choice from the Game menu

Sound          

Clicking on this button toggles Blackout's sound setting.    When the button appears pressed, Blackout will
make the normally-assigned game sounds.    When the button appears normal, Blackout will play silently.  
This button is equivalent to choosing the Sound choice from the Option menu.

Slow          

Clicking on this button switches the current game speed to slow.    This button is equivalent to choosing 
the Slow choice from the Option menu's Speed menu.

Medium

Clicking on this button switches the current game speed to medium.    This button is equivalent to 
choosing the Medium choice from the Option menu's Speed menu.

Fast            

Clicking on this button switches the current game speed to fast.    This button is equivalent to choosing the
Fast choice from the Option menu's Speed menu.

Help            

Clicking on this button displays Blackout's on-line help system index.    This button is equivalent to 
choosing the Index choice from the Help menu.    Context-sensitive help is always available in Blackout by
pressing the F1 key at any time.



Configuring Blackout

This section contains information about configuring Blackout.    Game-playing parameters are set by 
selecting the Configure Game... choice from the Game menu, and filling out the Game Configuration 
dialog box that is displayed. Sound setup parameters are changed by selecting the Sound Setup... choice
from the Game menu, and filling out the Sound Setup dialog box that is displayed.



The Game Configuration dialog box

The game configuration dialog box can be used to change Blackout's scoring rules, playing behavior, 
default values, and game size. The dialog box is divided into five sections, each containing parameters for
a general aspect of the game's behavior, and five push buttons for controlling the operation of the dialog 
box:

Scoring Parameters: Specify new values for the 3 different scoring rules and the target counts 
for playing level one and the increment for each subsequent playing 
level.

Playability Parameters: Specify new values for the 4 different playability settings.

New Game Defaults: Specify the new-game defaults for playing level and playing speed.

Options: Switch any of the game options on or off.

Game Size: Specify new values for the game size - allows you to change the number 
of rows and/or columns used for the game-grid.

After you have finished entering configuration values, you can press one of the five buttons at the bottom 
of the dialog box to tell Blackout what to do with your values. The five buttons do the following:

Save As Default
Apply Changes
Current Defaults
Original Defaults
Close



Tells Blackout to save all current parameters in the dialog box to disk, to be used for new games.    This 
choice also applies any changes to any current game in progress.



Tells Blackout to return to the current game, using all parameters in the dialog box as the current playing 
parameters, without saving the parameters to disk.    Use this button to test parameter changes without 
saving them permanently.



Tells Blackout to restore the current default parameters from disk, replacing any parameters shown in the 
dialog box with the saved values.    This also applies the saved defaults to any current game in progress.



Tells Blackout to restore the original parameters as shipped from Zarkware, replacing any parameters 
shown in the dialog box with the original values.    This also applies the original defaults to any current 
game in progress.



Tells Blackout to close the Game Configuration dialog box.    Unless you have pressed one of the other 
four buttons described above, pressing the Close button will have no effect on either the saved 
parameters or the current playing parameters.    You may press the Close button to cancel any changes 
you were making, if you change your mind before you have pressed one of the other buttons.



The row and column values in the Game Size section control how many rows and columns of blocks 
Blackout displays in the game grid.    Permissible values are from 5 to 50 rows and from 5 to 75 columns.

Smaller game sizes are often combined with changes to the Playability Parameters above (especially to 
decrease the probability for a black block in order to slow game play), to make Blackout easier for small 
children and novice mouse users.

If you change the Game Size settings and click the "Apply" or the "Save As Default" button, the current 
game will be ended and a new game started when you click the "Close" button.



Scoring Parameters

This section explains how the values of the scoring parameters are used by Blackout to compute scoring 
during game play.    The values of the scoring parameters can be changed by choosing Configure Game...
from the Game menu and modifying the values in the Scoring/Target Count section of the game 
configuration dialog box.

Blackout modifies the current game score when any one of three different events happens:

· The player correctly locates and clicks on a target block

· The player incorrectly clicks on a block that is not playable, such as a found target, found bonus 
block, or a target that is not the next target in sequence, when sequenced play is enabled

· A block randomly turns black

The score is increased whenever the first event happens, and decreased whenever either of the other two
happens.    Each of these events has two scoring parameters.

The first parameter is the point change for the event during play at level-one.    The second is the amount 
to increment the first value at each subsequent level of play.    For example, if the parameters for an event
of the first type (correctly finding a target block) are set to 10 and 5, the score change for that event would
be computed as follows, if the current playing level was three:

To the current score, add 10 (the value for level-one play) plus 2 times 5 (the number of levels above level
one times the increment value).    Since 10 + (2 x 5) = 20, the score would be increased by 20 points.

The other two sets of scoring parameters work exactly as described above, except that the score is 
decreased instead of increased.    If the score would fall below 0 as a result of the calculation, it is simply 
set to 0.

The values used in the Scoring Parameters section of the game configuration dialog box must be positive 
integers in the range of 1 to 100.

The fourth set of parameters in this section control the number of targets displayed by Blackout at level-
one play and at each subsequent level.    These parameters work exactly as described above for the 
scoring parameters, except that they control the number of targets displayed, rather than a score change. 
Blackout will adjust the number of targets specified by these parameters so that never more than 50% of 
the total number of blocks displayed on the playing surface are targets.



Playability Parameters

This section explains how the values of the playability parameters are used by Blackout to compute 
scoring during game play.    The values of these parameters can be changed by choosing Configure 
Game... from the Game menu and modifying the values in the Frequencies (Playability) section of the 
game configuration dialog box.

During play, Blackout randomly picks blocks on the playing surface and modifies their colors and 
properties, perhaps just changing a block's color , but possibly changing the block to a black block, or to a
Bonus Block, Replay Arrow, or Boogeyman. Blackout's decision to change a block is made on the basis of
random probability.    Four of the possible kinds of block changes (to a Bonus Block, a Boogeyman, a 
Replay Arrow, or a simple black block), depend on playability parameters which specify the probability 
that a block will change.

The Playability section of the game configuration dialog box allows you to modify probabilities for these 
four changes.

Since the values in the Game Play Parameters section represent probabilities, they are divided into 1 and
compared to a random number between 0 and 1, generated during each Blackout game cycle (during 
play, a game cycle occurs once every millisecond, or as often as your computer can carry out a game 
cycle, if it cannot complete a game cycle in one millisecond).    If the random number is greater than the 
probability, then a change is made.

For example, if you set the value of the Replay Arrow parameter to 500, there would be one chance in 
500 for a Replay Arrow in any given game cycle.    If the random number computed during the current 
game cycle was less than 1/500, then a replay arrow would be generated.

As another example, if you set the value of the "Black Blocks" playability parameter to 10, there would be 
one chance in 10 for a block to turn black in any given game cycle.    If the random number computed 
during the current game cycle was less than 1/10, then a block would be turned black.

The playability parameters must all be positive integers in the range 1 to 9999.



New Game Defaults

This section explains how the default playing level and speed can be set, so that each time you start a 
new game in Blackout, your preferred playing level and speed are automatically chosen.    The new game 
defaults can be set by choosing Configure Game... from the Game menu and selecting the desired 
startup playing level and speed from the scrolling combo-boxes in the Defaults section of the game 
configuration dialog box.

There are 10 levels of play available in Blackout, numbered 1 through 10, and three playing speeds - 
Slow, Medium, and Fast.    The difficulty of play increases at higher levels and speeds and decreases at 
lower levels and speeds.

When the game configuration dialog box is displayed, the current default starting level and speed will be 
displayed in the combo-boxes in the Defaults section of the game.    Note that these are not necessarily 
the same as the current playing level and speed - when you change these values, you are changing the 
Startup Defaults, not the current values.    If you want to change the current playing level or speed, you 
should use the Level and/or Speed choices from the Options menu.



Options

This section explains Blackout's game options.    These options can be turned on and off by choosing 
Configure Game... from the Game menu and clicking on the checkmark boxes in Options section of the 
Game Configuration dialog box.

There are a number of game options in Blackout.    Each one can either be On or Off.    The options and 
their effects are:

Bonus Blocks

When set On, this option results in bonus blocks appearing with whatever probability is set for bonus 
blocks in the Playability section.    When set to Off, no bonus blocks will appear.

Boogeymen

When set On, this option results in boogeymen appearing with whatever probability is set for boogeymen 
in the Playability section.    When set to Off, no boogeymen will appear.

Replay Arrows

When set On, this option results in replay arrows appearing with whatever probability is set for replay 
arrows in the Playability section.    When set to Off, no replay arrows will appear.

Bouncing Arrows

When set On, any replay arrow on the screen will reverse its direction when it collides with a target block. 
Setting this option to On allows targets to be "trapped" on screen between two target blocks.    If an arrow 
originates in a block occupied by a target, it simply passes through the target.    When set to Off, replay 
arrows pass through all targets they encounter.

Moving Targets

When set to On, target blocks will move across the screen, bouncing off of the edges of the playing 
surface in random directions.    When set to Off, target blocks always stay in the same place, unless 
dragged to a different location.

Sequenced Play

When set to On, one target block on the screen is turned yellow, and in order to play the game, the player
must click on the yellow target.    Clicking on other targets will result in those targets being blacked out.    
When the yellow target is either clicked or destroyed, another target is chosen and turned yellow.    When 
set to Off, all targets are considered playable at any time.

Drag Targets

When set On, you may drag targets, by clicking on them with the right mouse button (not the left one), 
and dragging them to a new location.    You can do this in order to set "arrow traps" when you are using 
bouncing arrows.    In order for this technique to work, you must set moving targets off, so that your arrow 
traps will remain "set".    When set to Off, dragging targets is not permitted.



The Sound Setup dialog box

The sound setup dialog box can be used to change Blackout's sound assignments.    Using this dialog 
box, you can assign any of Blackout's eight sound events to either an internally-generated sound-effect, 
or to a multimedia .WAV file.    Blackout comes with a collection of .WAV files for you to experiment with, 
and if you have your own .WAV files, you can use them as well.    Some of the .WAV files supplied with 
Blackout were developed by Data Assist, Inc., and are used with their permission.    You can contact Data 
Assist by looking in the Credits section for their address and phone number.

Note that you should not specify .WAV files unless you have the appropriate sound hardware and 
software-drivers installed to allow their use.    Blackout will not correctly play .WAV files without the correct
hardware and Windows software drivers.    The .WAV file driver for the PC speaker will work with 
Blackout, but since it may stop the computer's operation while the sound is played, you may prefer using 
Blackout's internal sound-effects rather than the PC-speaker .WAV driver.

Blackout can make a sound whenever one of the following events happens:

Got Replay Arrow
Got Bonus Block
Got Target
Missed Target
Got Bonus Points
Got Boogeyman
Level Over (no bonus)
Blackout!

Blackout's sound setup dialog box contains three sections.    You can change the sound assignments by 
selecting a sound from the Sound Event to Edit list, selecting the sound type from the Sound Type for 
Event options, and then choosing the source of the sound from the Source of Sound section.    To change 
an assignment, choose a new sound type and/or sound source, and click the Apply button (the Apply 
button will be grayed until you choose a new sound type and/or source).

There are three buttons in the sound setup dialog box 

Play
Apply
Close



This section contains a list box which allows the user to select an event to edit.    Clicking a selection 
shows the assigned sound type and sound source in the other two sections.    Double-clicking a selection 
plays the currently-assigned sound for that selection.



This section contains two radio buttons which allow the user to choose whether the event selection in the 
Sound Event list box will be played from an internal sound-effect (the "Speaker/Sound Device option"), or 
from a .WAV file (the "Wave File (*.WAV)" option)



The Source of Sound section

This section's contents change, depending on which option is selected from the Sound Type for Event 
section.

If the "Speaker/Sound Device" option is selected, this section will display a list box containing a list of 
possible sound "voices" that can be used to play the internal sound-effect.    If you have the standard 
sound drivers installed, the PC Speaker will be used to play these sounds, and the only choice in this box 
will be the speaker "Beep" sound.    If you have special sound drivers (see the Credits section for more 
information) installed for a synthesizer card, you may see a list of different "voices" in this list box.    
Single-clicking a voice-name in the list box will enable the "Apply" button so that you may change the 
selected event's setting to that voice.    Double-clicking a voice-name in the list box will play the current 
event's sound-effect using that voice.

If the "Wave File (*.WAV)" option is selected, this section will contain directory and file list boxes, and 
you can use them like a standard "file open" dialog box to select a wave file for the event selected in the 
Sound Event list box.    Single-clicking a file in the file list box will enable the "Apply" button so that you 
may change the selected event's setting to the selected file.    Double-clicking a file in the file list box will 
play that file.

When you are selecting .WAV files using the disk, directory and file lists, be sure to take advantage of 
Blackout's handy most-recently-visited directories drop-down list (located right above the disk-drive drop-
down list).    This contains all the directories from which you have assigned .WAV files, as well as any 
other directories you have visited which contained .WAV files.    This allows you to quickly move between 
any directories containing .WAV files, without having to move to them using the standard disk and 
directory lists.



Tells Blackout to play the sound for the currently selected event, using the current settings in the dialog 
box.    This button can be used to test new settings without saving the settings for use.



Tells Blackout to save the change you have made to a sound event for current and future use.    If you 
have not changed any settings for the current event, this button is disabled.



Immediately closes the sound setup dialog box and returns to Blackout.



This sound is made whenever a replay arrow is successfully clicked.



This sound is made whenever a bonus block is successfully clicked.



This sound is made whenever a target block is successfully clicked.



This sound is made whenever a mouse click is detected over a block that is not a target, bonus block, 
arrow or boogeyman block.



This sound is made at the end of a playing level when all target blocks were found, clicked, and are still 
visible on the playing surface as "found targets".    Bonus points are awarded for this accomplishment.



This sound is made whenever a boogeyman is successfully clicked.



This sound is made at the end of a playing level when no bonus points are awarded.



This sound is made whenever a blackout has occurred.



Entering your Registration Number

Unregistered copies of Blackout display a "pester screen" dialog box, reminding users to register the 
software, whenever a new game or playing level is started.    When you register Blackout, you will receive 
a registration number that can be used to eliminate this "pester screen" and provide uninterrupted game 
play. This section describes how to enter the registration number into Blackout.

To enter your registration number, perform the following steps:

1) After correctly installing Blackout on your system, start the game.

2) Choose the "About..." choice from Blackout's Help menu.

3) Blackout will display a "Blackout Registration" box.    Just type your number into the space provided 
and use the mouse to press the "OK" button.    That's all there is to it.    As long as you entered your 
number correctly,    Blackout will no longer display the "pester screen", and a different dialog box will 
display when you choose the "About..." choice from the Help menu.

4) Please note that if you delete the "BLACKVB.INI" file in your Windows directory, you will need to go 
through the registration process again in order to eliminate the "pester screen" feature in unregistered
copies of Blackout.    Save your registration number, so that you can re-do the registration process, if 
necessary.



How to Play

This section can take you to topics which describe how to play Blackout.

Overview A general description of Blackout
Playing the Game Good basic description of playing the game
Rules of the Game More detailed instructions on play
Strategy and Hints How to increase your scores and play more effectively



Commands

This section contains information about the menu commands in Blackout.

Game Menu Commands
Options Menu Commands



Credits and additional information

This section contains information about others who have helped with Blackout, or who make products or 
services which can help you to enjoy playing Blackout more..

Some of the .WAV files included with Blackout were produced by Data Assist, Inc., using their fine 
shareware product WavePool, which allows programmatic generation of .WAV files.    If you need to 
produce such files, or if you need to hire someone to produce them for you, contact Data Assist at the 
following address:

Data Assist, Inc.
P.O. Box 26114

Columbus, OH    43226

Phone:    (614) 888-8088

I gratefully acknowledge Data Assist's kind permission to include the .WAV files which are part of their 
WavePool shareware package with Blackout.

If you have a synthesizer card in your computer, and you install the appropriate sound driver, Blackout will
allow you to assign any of its eight internally-generated sounds to one of the different "voices" of your 
synthesizer card.    One company which makes software that allows Blackout to do this is Future Trends, 
Inc.    You can contact Future Trends about their EZ Sound FX software at this address:

Future Trends Software, Inc.
1508 Osprey Drive, Suite 103

Desoto, TX    75115

Phone:    (214) 224-3288



How to Register

This section contains information about how to register Blackout.

Blackout is Shareware!    Shareware is software you can use before you decide to buy it.    If you try 
Blackout and like it, please show your support by registering today.    The cost is only $15 and registering 
will get you a registration number that will eliminate the pester screen at the start of each new game, for 
this and all future versions of Blackout you may use.

In addition, your registration will include instructions on how to get two extra toolbar buttons that will make
playing Blackout more fun. You will also receive instructions for BLACKVB.INI file settings which allow you
to completely change the appearance of the 3D effects and other display features.

To register Blackout, please send a check or money order for $15 to:

Zarkware
2243 E. Thompson

Springfield, MO    65804

(For orders from outside the United States, include an extra $2.00 for shipping and handling.)

For questions or comments about Blackout, or to get technical support, contact Patrick L. Mills at the 
above address, or send Email to Compuserve ID 71211,1250.

To print an order form for Blackout, just click on the words order form in this sentence, and choose Print 
Topic from the help system's File menu.



Blackout Order Form
To order Blackout, just pick Print Topic from the File menu above.    Fill out the form and mail it with a 
check or money-order for $15 made out to Zarkware to:

Zarkware
2243 E. Thompson

Springfield, MO    65804

For orders outside the United States, please add $2 for shipping and handling.    Please allow three weeks
for delivery.

Your Name: __________________________________

Your Address (for mail delivery): __________________________________

__________________________________

__________________________________

__________________________________

Your Phone Number: __________________________________

Version of Blackout you are using: __________________________________

Where did you get your copy of Blackout? __________________________________

What size disk do you prefer? (3½ or 5¼): __________________________________



Advanced Help Topics for Registered Users

Adding Additional Buttons

To add the additional toolbar buttons, you must first use the About option from the Help menu and view 
Blackout's About dialog box.    Immediately after clicking the "Ok" button in the About dialog box, hold 
down the Ctrl and Shift keys, and click the right (not the left) mouse button somewhere on the game's 
playing grid.    You should see the additional toolbar buttons appear.    

The buttons do the following:

Replay Arrow Force a replay arrow to appear
Boogeyman Force a boogeyman to disappear

These buttons can be used to prolong levels and allow higher scoring.

Additional INI file Settings

The following INI file settings can be placed in the BLACKVB.INI file to allow customization of the game's 
appearance and 3D effects:

NormalDrawWidth=x (Default=1) Width of black lines between blocks
3DBorderWidth=x (Default=1) Width of the 3D border
3DShadowColor=x (Default=8) 3D shadow color (0-16 valid)
3DLightColor=x (Default=15) 3D light color (0-16 valid)

With the 3D settings, you can make the 3D effect look like raised tiles (by using a light color of 15 and a 
shadow color of 7), or you could create a depressed-tile appearance by using a light color of 7 and a 
shadow color of 8. Mix and match the shadow and light colors and 3D border widths for a number of 
different 3D effects.    The best light and shadow colors are:

0 Black
7 Light gray
8 Dark gray
15 White

Thanks for registering Blackout 3.0.    We appreciate your support!




